OpenEnterprise Notes Server Reference Guide (V2.83)
Contents

1 Notes Server ............................................................................................................................. 1
  1.1 Client-Server Application Architecture ................................................................................ 1
  1.2 Pre-Starting Server Components ........................................................................................ 1
  1.3 Auto Termination and the Notes Server .............................................................................. 1
  1.4 User Interface ...................................................................................................................... 2
    1.4.1 Main Dialog ................................................................................................................... 2
    1.4.1.1 File Menu ............................................................................................................... 2
    1.4.1.2 Edit Menu ............................................................................................................. 2
    1.4.1.3 View Menu ............................................................................................................. 3
    1.4.1.4 Help Menu .............................................................................................................. 3
    1.4.1.5 Databases List ....................................................................................................... 3
    1.4.1.6 Toolbar ................................................................................................................... 3
    1.4.2 Properties Dialog .......................................................................................................... 3
      1.4.2.1 General Tab ........................................................................................................... 3
        1.4.2.1.1 Show System Tray Icon ................................................................................ 4
        1.4.2.1.2 Show Window ............................................................................................... 4
        1.4.2.1.3 Minimized ..................................................................................................... 4
        1.4.2.1.4 Hide on Minimize .......................................................................................... 4
        1.4.2.1.5 Batch Size ................................................................................................... 4
        1.4.2.1.6 OK Button .................................................................................................. 4
        1.4.2.1.7 Cancel Button ............................................................................................ 4
      1.4.2.2 Databases Tab ....................................................................................................... 5
        1.4.2.2.1 Auto-connect Database List .......................................................................... 5
        1.4.2.2.2 Add Button .................................................................................................. 5
        1.4.2.2.3 Remove Button ............................................................................................. 5
        1.4.2.2.4 OK Button .................................................................................................. 5
        1.4.2.2.5 Cancel Button ............................................................................................ 5
        1.4.2.2.6 Apply Button ............................................................................................... 5
        1.4.2.2.7 Add New Database Dialog .......................................................................... 5
          1.4.2.2.7.1 New Database ......................................................................................... 6
          1.4.2.2.7.2 OK Button .............................................................................................. 6
          1.4.2.2.7.3 New Database Cancel Button ................................................................ 6
  2 Index ......................................................................................................................................... 7
1 Notes Server

The Notes Server is a software component that provides data requested by the Notes View (which is a 'client' of the Notes Server). The Notes Server 'serves' the Notes View with data from the database.

Like all of the Client Server components, the Notes Server has its own User Interface (UI), which enables the user to specify and view the databases to which it is connected, and control the way the UI behaves. When it is running, its icon is visible in the System Tray at the bottom right of the Windows Desktop - 📱. To display the UI, double click on this icon in the System Tray.

1.1 Client-Server Application Architecture

Most OpenEnterprise View components (e.g. Alarm View, Alarm Printer View, Trend View, OEGraphics View, Notes View) have what is known as three-tier Client-Server architecture. Each of the components listed above is a Client, which uses one or more Server components to provide them with the data that they request. This data is then displayed by the Client to the user. In turn, the Server component requests the data from what is usually a remote OpenEnterprise data source (Database Management System) running on an OpenEnterprise server. The Server component, is therefore a direct client of the OpenEnterprise database, but a Server of the OpenEnterprise View component (hence the term "three-tier"). Both Client and Server components must run on the same workstation, but the database usually runs on another machine.

1.2 Pre-Starting Server Components

All Server components are started automatically as a background process when a Client component starts up. They then close when the Client closes, except for the OPC and HDA Servers, which remain open by default. However, this can cause problems when Client components are being opened and closed rapidly. It is therefore recommended that Server components be started before any Client components begin requesting data from them. Obviously, if a Client component is not required, then the Server component is not required. The following are the Server components that should be started on an OpenEnterprise workstation before any of their 'Clients' begin running:

- The Bristol OPC Server (Clients = OEGraphics and Trend View)
- The Bristol HDA Server (Client = Trend View)
- The Alarm Server (Clients = Alarm View, Alarm Banner)
- The Alarm Printer Server (Client = Alarm Printer View)
- The Notes Server (Client = Notes View)

These components reside in the OpenEnterprise bin directory (by default C:\Program Files\Bristol\OpenEnterprise\bin). They are executables, and may be started in any of the ways that an executable file is started (e.g. double clicking, batch file, Startup menu).

1.3 Auto Termination and the Notes Server

By default, the Notes Server remains open when a calling Client closes.

This behaviour can be changed using the OpenEnterprise Settings Editor. Open the Settings Editor, and find the OpenEnterprise\Tasks\Notes Client Server key. Then look for a value on this key named AutoTerminate. If one is not there already, create one, and set the data to 1.
To set the Server back to normal behaviour (i.e. to remain open when the Client closes) set the value data back to 0 (zero).

1.4 User Interface

1.4.1 Main Dialog

The Main Dialog displays the databases to which the Notes Server has attempted a connection, and the status of that connection. It also provides access to the Notes Server's Property pages.

1.4.1.1 File Menu

The File Menu provides an option to Exit the application. This will cause the application to close as a Windows process if the Notes Server is not currently supplying data to a client, but if it has a subscribing client, it will hide itself, but remain running as a process. The UI can be invoked again by double clicking on its icon in the System Tray.

1.4.1.2 Edit Menu

The Edit Menu provides an option to open the Properties dialog, which enables the user to configure pre-connect databases and the way that the UI behaves.
1.4.1.3 View Menu

There are two options available from this menu:

1. **Toolbar** - when checked, the toolbar is visible under the Menu bar.

2. **Status Bar** - when checked, the Status Bar is visible at the bottom of the Main Dialog window. It displays information on the current status of the Notes Server.

1.4.1.4 Help Menu

This provides an option to open the About dialog, which provides information on the version and build of OpenEnterprise being used and contact information.

1.4.1.5 Databases List

Successful or failed database connections are displayed here. The database name and the connection status of the Notes Server is supplied.

1.4.1.6 Toolbar

This contains two icons:

- Properties icon - selection opens the Notes Server Properties dialog.
- About icon - selection opens the About dialog, which provides information on the version and build of OpenEnterprise being used and contact information.

1.4.2 Properties Dialog

The Edit Menu on the Main Dialog provides an option to open the Properties dialog, which enables the user to configure pre-connect databases and the way that the UI behaves. The Properties Dialog has two configuration tabs:

- General Tab
- Databases Tab

1.4.2.1 General Tab

This tab on the Property dialog enables the user to configure the way that the Notes Server User Interface behaves. Changes are implemented when the user selects the [OK] button at the bottom of the Properties dialog.
1.4.2.1.1  **Show System Tray Icon**

When checked, the Notes Server icon will be displayed in the System Tray when it is running. Double clicking on this icon in the System Tray will open the Notes Server's User Interface.

1.4.2.1.2  **Show Window**

When checked, the Notes Server's User Interface will be displayed on startup.

1.4.2.1.3  **Minimized**

When the *Show Window* box is checked, this option becomes enabled. If checked, on startup the Notes Server's User Interface will be displayed as a minimized icon on the Windows Task Bar.

1.4.2.1.4  **Hide on Minimize**

If checked, when the Notes Server's User Interface is minimized, it will also be hidden. If the *Show System Tray Icon* box and *ShowWindow* boxes are unchecked at the same time that this box is checked, then at startup the Notes Server's User Interface will not be available.

The interface may be restored by using the Settings Editor to manually change the *ShowtrayIcon* value on the `OpenEnterprise\Tasks\Notes Client Server` key to 1. A restart will be necessary before the change takes effect.

1.4.2.1.5  **Batch Size**

This field allows you to specify the maximum number of Notes transactions that will be packaged by the Notes Server into a single batch before being sent to the Notes View client.

1.4.2.1.6  **OK Button**

When this button is selected, changes made to any tab are saved, and the Property dialog is closed. Changes will be applied immediately.

1.4.2.1.7  **Cancel Button**

When this button is selected, the Property dialog is closed without saving any changes made on either tab.
1.4.2.2 Databases Tab

This tab on the Property dialog enables the user to configure databases that the Notes Server will attempt to connect to next time it is started.

1.4.2.2.1 Auto-connect Database List

A list of databases that the server will automatically connect to when it starts up. Configuring databases that the Notes Server will automatically connect to on start-up improves the usability of the Notes View client.

1.4.2.2.2 Add Button

Selection of this button opens the Add New Database dialog, which enables you to define and add a new Common Database to the list.

1.4.2.2.3 Remove Button

Selection of this button removes a selected database from the Auto-connect Databases list.

1.4.2.2.4 OK Button

When this button is selected, changes made to any tab are saved, and the Property dialog is closed. Changes will be applied immediately.

1.4.2.2.5 Cancel Button

When this button is selected, the Property dialog is closed without saving any changes made on either tab.

1.4.2.2.6 Apply Button

When selected, any changes made on the dialog are saved, but the dialog is not closed down.

1.4.2.2.7 Add New Database Dialog

This dialog enables a Common database to be defined and configured for the Notes Server. The Notes Server will attempt connection with all defined Common databases on start-up, regardless of whether any Notes View clients are requesting data.
1.4.2.2.7.1 New Database
Type in the name of the new database here. A database name is comprised of <ServerName>:<DataPortConnection>. By default the DataPortConnection is defined as rtrdb1 and has a TCP/IP port value of 11001 in the <Drive>:\<WinFolder>\System32\Drivers\etc\Services file.

1.4.2.2.7.2 OK Button
When this button is selected, the database defined in the New Database field will be added to the Common Databases list.

1.4.2.2.7.3 New Database Cancel Button
When selected, this button closes the Add New Database dialog without adding the name currently defined in the New Database field to the Common Databases list.
2 Index

A
Add Button ......................................................... 7
Add New Database Dialog................................. 7
Apply Button....................................................... 7
Auto-connect Database List............................... 7
AutoTerminating OPC........................................ 3

B
Batch Size .......................................................... 6

C
Cancel Button.................................................... 6, 7
Client-Server Application Architecture ............... 3
Connected Databases List.................................... 5

D
Databases Tab................................................... 6

E
Edit Menu ........................................................... 4

G
General Tab ....................................................... 5

H
HDA Servers ....................................................... 3
Help Menu .......................................................... 5

Hide on Minimize ................................................. 6

M
Main Dialog........................................................ 4
Minimized .......................................................... 6

N
New Database ..................................................... 7
New Database Cancel Button............................. 7
New Database OK Button................................... 7
Notes Server Overview ....................................... 3

O
OK Button ....................................................... 6, 7

P
Pre-Starting Server Components.......................... 3

R
Remove Button ................................................... 7

S
Show System Tray Icon...................................... 6
Show Window ..................................................... 6

V
View Menu .......................................................... 4
DISCLAIMER

Bristol, Inc., Bristol Babcock Ltd, Bristol Canada, BBI SA de CV and the Flow Computer Division, are wholly owned subsidiaries of Emerson Electric Co. doing business as Remote Automation Solutions ("RAS"), a division of Emerson Process Management. ROC, FloBoss, ROCLINK, Bristol, Bristol Babcock, ControlWave, TeleFlow and Helicoid are trademarks of RAS. AMS, PlantWeb and the PlantWeb logo are marks of Emerson Electric Co. The Emerson logo is a trademark and service mark of the Emerson Electric Co. All other marks are property of their respective owners.

The contents of this publication are presented for informational purposes only. While every effort has been made to ensure informational accuracy, they are not to be construed as warranties or guarantees, express or implied, regarding the products or services described herein or their use or applicability. RAS reserves the right to modify or improve the designs or specifications of such products at any time without notice. All sales are governed by RAS' terms and conditions which are available upon request. RAS does not assume responsibility for the selection, use or maintenance of any product. Responsibility for proper selection, use and maintenance of any RAS product remains solely with the purchaser and end-user.

Engineered and supported by:

Remote Automation Solutions,
Blackpole Road, Worcester, WR3 8YB, UK

Registered office: Meridian East, Leicester, LE19 1UX

Registered in England and Wales, Registration No. 00671801

VAT Reg No. GB 705 353 652